
LESSON THREE: LIFE AS A COLONIAL SLAVE 
 
 
INTRODUCTION 

The history of the African-American family is a story of the struggle to rebuild stable 
family institutions to fill the emotional, cultural, and spiritual void created when African people 
were torn from their homelands. Despite the separation from homelands and the legalities of 
slavery, black men and women continued to form unions, joining together in marriage 
ceremonies. Although many of these couples lived apart from one another, many traveled great 
distances at night to visit their loved ones. This “night walking,” a family institution born of 
necessity, employed a network of foot trails that became physical landmarks of the family ties 
that bound the black community together.  
 Enslaved Africans established families, extended kin connections, and formed networks 
with those at other plantations. These kinships and networks also included free blacks. The world 
blacks made for themselves helped to mitigate the isolation and debasement of the slave system. 
Africans and their Virginia-born descendants developed their own system of social relationships 
in the quarters and a semi-autonomous culture that borrowed from both African and English 
traditions. The practice of a distinctive culture that whites could not entirely control afforded 
African-Virginians some small measure of power over their lives. In addition, these enslaved 
Africans were able to affect daily living conditions and relationships with their masters.  
 
OBJECTIVES 
As a result of this lesson, students will be able to: 

1. Provide information on the characteristics of African-Americans’ living conditions, daily 
routines, and material culture.  

2. Make inferences about a slave’s living conditions, including family life, work conditions, 
daily routines, and material culture. 

3. Read and interpret eighteenth-century documents, and provide answers to questions 
related to these resources.  

4. Respond to “Documents-Based Questions,” utilizing the primary sources provided.  
 
MATERIALS NEEDED 

Painting: “The Old Plantation” 
Story: “Dividing Up Souls” 
Excerpt from The Journal of Nicholas Cresswell, 1774–1777 
Excerpt from Autobiography of Dick, a Slave 
Spiritual: “Gonna Shout All Over God’s Heaven” 
Artifact: Cowrie Shells 
Scaffolding Questions—Teacher Answer Key 
LearningCheck ™ File: ColonialSlaveQuestions 
Class set of TI-83 Pluses or TI-83 Plus Silver Editions 
TI-Navigator™ Classroom Learning System 
LearningCheck™ Application for the TI-83 Plus and TI-83 Plus Silver Edition 
LearningCheck Creator™ 
Class set of TI-Keyboards 
TI-Navigator Instructions Tip Sheet (optional) 
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PROCEDURE 
 
SETTING THE STAGE 

1. Give each student a copy of the six primary source documents. 
 
2. Send the Scaffolding Questions that are contained in LearningCheck ™ AppVar 

ColonialSlaveQuestions through the TI-Navigator™ system by selecting the Add to 
Transfer List option within the Edit menu of the TI-Navigator tool bar. [NOTE: For more 
detailed instructions on sending already-created files to students with the TI-Navigator™ 
system, refer to the TI-Navigator™ Instructions Tip Sheet.] 

 
3. Using the LearningCheck™ ColonialSlaveQuestions AppVar, have students respond to 

the questions associated with each primary source document. 
 
4. Using the TI-Navigator™ system, select the Class Analysis icon within the left 

navigation panel of the software’s tool bar. From within the Class Analysis tool, select 
the Collect From Class option in order to view student responses to the questions 
associated with each of the primary source documents. [NOTE: Refer to the TI-Navigator 
Instructions Tip Sheet for guided instructions.] Use these responses as the basis for a 
class discussion. During the discussion, answers can be clarified and inaccuracies 
corrected. At the teacher’s discretion, several or all of the documents may be addressed. 

 
STRATEGY/EVALUATION 

Using their answers to the Scaffolding Questions and their knowledge of American history, 
have students respond to the following question. All student answers should be written in 
essay form and make use of information obtained from at least three of the primary source 
documents. 
 

“Based on the documents, what evidence is there that a unique African-American 
culture was created and maintained in the American colonies?”
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“The Old Plantation,” possibly South Carolina, ca.1790–1800.
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STORY: “DIVIDING UP SOULS” 
 

It seems that a couple of slave boys on Master White’s plantation felt like they weren’t 
getting enough to eat, because one Saturday night they stole a bag of potatoes. Now they needed 
a place to divide them up where no one would hear them, so they took them to the graveyard. No 
one would hear them there. 

Well they were dragging the bag to the graveyard – it was pretty heavy, you see. By the 
time they got to the graveyard they’d dragged a hole into the bag, and when they threw the bag 
over the gate two of the potatoes fell out. They were in a hurry and decided they’d pick up those 
two potatoes on their way back out. They jumped on over the gate and headed for the deepest, 
darkest corner of the graveyard. 

Now neither one of them could count very high, so they began dividing the potatoes one 
at a time in a kind of a sing-song voice: 

“You take this one, and I’ll take that one. You take this one, and I’ll take that one.” 
About that time Ol’ Tom passed by, on his way home from a gathering. He always 

walked by the graveyard. It didn’t bother him at all – dead people don’t bother anybody. But 
when he got to the part of the wall at the back of the graveyard, he thought he heard something. 
He stopped dead in his tracks and tried not to breathe. Then the hair on the back of his neck 
stood straight up, because sure enough, inside the graveyard he heard voices: 

“You take this one, and I’ll take that one. You take this one, and I’ll take that one.” 
“Oh Lord,” he thought. “It’s the day of judgement! That’s the Lord and the Devil in 

there, dividing up souls!” And he ran home, just as fast as he could go, to tell his master. 
“Master, Master! Wake up! It’s the day of judgement! The Lord and the Devil are in the 

graveyard right now, dividing up souls! You’ve got to come and see!” 
 Now Master Johnson didn’t really believe Ol’ Tom, and told him he’d be mighty sorry if 
he was lying. But he was curious just the same, so he got up and pulled on his breeches and 
riding boots. He didn’t bother with his wig – this time of night nobody’d see him anyway. And 
the two of them headed back over to the graveyard. 

As the got close, they began to hear the voices. 
“You take this one, and I’ll take that one. You take this one, and I’ll take that one.” 
They crept right up next to the gate, so they could hear better. 
“You take this one, and I’ll take that one. You take this one, and I’ll take that one.” 
Just about that time the two boys reached the bottom of the bag. There were only two 

potatoes left, and they remembered the two they’d dropped by the gate on the way in. So they 
divided up the last four, saying: 

“You take these two, and I’ll take those two over there by the gate.” 
And the master and Ol Tom ran home just as fast as their legs could carry them, and to 

this day, Master Johnson’s never doubted a thing Tom said. 
 
 
Source: Oral Tradition. 
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EXCERPT FROM THE JOURNAL OF NICHOLAS CRESSWELL, 1774-1777 
 

Nicholas Cresswell, born in Edale, England, was 24 when he went to America in 1774. 
Cresswell made the journey because he believed that “a person with a small fortune may live 
much better and make greater improvements in America than he can possibly do in England.”  
Sailing from Liverpool, he went to Virginia, and returned to Edale in 1777. 
 

. . .Went to see a Negro Ball. Sundays being the only days these poor creatures 
have to themselves, they generally meet together and amuse themselves with 
dancing to the Banjo. This musical instrument (if it may be so called) is made of a 
Gourd something in the imitation of a Guitar, with only four strings and played 
with the fingers in the same manner. Some of them sing to it, which is very droll 
music indeed. In their songs they generally relate the usage they have received 
from their Masters or Mistresses in a very satirical stile and manner. Their poetry 
is like the Music – Rude and uncultivated. Their dancing is most violent exercise, 
but so irregular and grotesque. I am not able to describe it. They all appear to be 
exceedingly happy at these merry-makings and seem as if they had forgot or were 
not sensible of their miserable condition. 

 
 
Source: Nicholas Cresswell, The Journal of Nicholas Cresswell, 1774-1777, (New York: The Daily Press, 1928). 
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EXCERPT FROM “AUTOBIOGRAPHY OF DICK, A SLAVE” 

 Dick’s autobiography comes from a travel book written by John Davis, an Englishman 
who traveled throughout the new republic between 1798 and 1802. Davis described Dick as a 
man of about sixty years, dressed in ragged clothing, and slow of movement but still engaged in 
a variety of jobs for his owner. The excerpt describes Dick’s life in Virginia, where he lived both 
before and after the Revolution. 
 

“I was born at a plantation on the Rappahannoc River. . . .  
 When I was old enough to work, I was put to look after the horses, and, 
when a boy, I would not have turned my back against the best negur at catching or 
backing the most vicious beast that ever grazed in a pasture. 
 ‘Squire Sutherland had a son who rode every fall to look at a plantation on 
James River, which was under the care of an overseer. Young master could not go 
without somebody on another horse to carry his saddle-bags, and I was made his 
groom. . . . 
 My young master was a mighty one for music, and he made me learn to 
play the Banger. I could soon tune it sweetly, and of a moonlight night he would 
set me to play, and the wenches to dance. My young master himself could shake a 
desperate foot at the fiddle; there was nobody that could face him at a Congo 
Minuet; but Pat Hickory would tire him at a Virginia Jig. . . . 
 My master at Annapolis being made a bankrupt, there was an execution 
lodged against negurs. I was sent to Alexander, and knocked down at vendue to 
old ‘Squire Kegworth. I was put to work at the hoe. I was up an hour before the 
sun, and worked naked till after dark. I had no food but Homony, and for fifteen 
months did not put a morsel of any meat in my mouth, but the flesh of a possum 
or a racoon that I killed in the woods. This was rather hard for an old man, but I 
knowed there was no help for it. 
 I was now once more put up at vendue, and as good luck would have it, I 
was bid for by ‘Squire Ball. Nobody would bid against him because my head was 
grey, my back covered with stripes, and I was lame of the left leg by the malice of 
an overseer who stuck a pitchfork in my ham. But ‘Squire Ball knowed I was 
trusty; and though self praise is no praise, he was not a negur on the plantation 
that wished him better than I; or a young man that would work for him with a 
more willing heart. There is few masters like the ‘Squire. He has allowed me to 
build a log-house, and take in a patch of land where I raise corn and water 
Melions. I keep chickens and ducks, turkeys and geese, and his lady always gives 
me the price of the Alexander market for my stock. . . . But I never wronged 
Master of a cent and I do the work of Hinton, of Henry, and Jack, without ever 
grumbling. I look after the cows, dig in the garden, beat out the flax, curry-comb 
the riding nag, cart all the wood, tote the wheat to the mill, and bring all the logs 
to the school house. 

 
 
Source: John Davis, Travels of Four Years and a Half in the United States of America During 1798, 1799, 1800, 
1801, and 1802 (New York: Henry Holt and Co, 1909). 
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SPIRITUAL: “GONNA SHOUT ALL OVER GOD’S HEAVEN” 

I’ve got a robe, you’ve got a robe 
All of God’s children got a robe 
When I get to Heaven goin’ to put on my robe 
Goin’ to shout all over God’s Heaven 

Heav’n, Heav’n 
Ev’rybody talkin’ ‘bout Heav’n ain’t goin’ there 
Heav’n, Heav’n 
Goin’ to shout all over God’s Heaven 

I’ve got a crown, you’ve got a crown 
All of God’s children got a crown 
When I get to Heaven goin’ to put on my crown 
Goin’ to shout over God’s Heaven 

I’ve got shoes, you’ve got a shoes 
All of God’s children got shoes 
When I get to Heaven goin’ to put on my shoes 
Goin’ to walk all over God’s Heaven 

I’ve got a harp, you’ve got a harp 
All of God’s children got a harp 
When I get to Heaven goin’ to play on my harp 
Goin’ to play all over God’s Heaven 

I’ve got a song, you’ve got a song 
All of God’s children got a song 
When I get to Heaven goin’ to sing a new song 
Goin’ to sing all over God’s Heaven 

 

Source: 18th-century song based on oral tradition. 

© 2003 Colonial Â 7



ARTIFACT IMAGE: COWRIE SHELLS 
 

 

Cowrie shells are indigenous to the Indian Ocean. In ancient civilizations, most notably 
those of Africa, cowrie shells were used as currency. Surprisingly, in areas such as Nigeria, the 
cowrie was used as recently as the early 1900s. In the thirteenth century, Arab and Dutch 
merchants transported cowrie shells to Africa. Eventually, the shells were traded among English 
merchants who were astonished to discover that Africans preferred the shells to gold, silver, or 
bronze. Though gold and silver were the standard currency for foreign exchange, cowries could 
be used to buy small items. 

Cowrie shells have been excavated from slave quarters and other areas frequented by 
enslaved Africans, at various archeological sites along the eastern seaboard. Many of these shells 
were found with man-made holes and other intentional alterations. 
 
[NOTES: The writing on the left cowrie shell is a Colonial Williamsburg Foundation accession 
number. Each artifact is assigned a unique accession number to facilitate tracking and to ensure 
that detailed information regarding its original location and archaeological context will always  
be available for research. Also, these shells are shown much larger than their actual size:  
Top shell—11/16” x 1/2”; Left shell—7/8” x 5/8”; Right shell—1” x 11/16”] 
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SCAFFOLDING QUESTIONS—TEACHER ANSWER KEY 
 
Painting: “The Old Plantation” 

Questions: 
1. The African-Americans in this painting are engaged in an activity. Historians have 

offered varying opinions about what the activity might be and its origins. What do 
you think is happening in this image?  

2. What three things can you identify in the painting to support your inferences?  
 

Possible Answers: 
This watercolor shows a plantation complex situated on a river bend. The facades 

of two small outbuildings frame the central action, whose exact nature, unfortunately, 
remains a matter of speculation. 

Several African-American scholars have suggested that it may illustrate a 
marriage ceremony; the act of jumping over a stick, especially a broomstick, has long 
borne such a connotation. Some authorities believe the dance or action being depicted is 
secular in nature. Dancing barefoot with sticks and scarves is common among the Yoruba 
of northern and southwestern Nigeria, and the cloth headdresses worn by several of the 
group are clearly of West African derivation—some scholars say specifically Yoruban. 

The musician on the right may be playing a Yoruba gudugudu, an animal skin 
stretched over a hollowed piece of wood to form a drumhead, which is then tapped by 
tightly twisted strips of leather. Others have suggested that he is playing a hollow gourd 
with sticks or bird bones. The stringed instrument is reminiscent of the Yoruba molo, an 
antecedent of the banjo. The body of this instrument appears to be a hollow gourd. 

 
 
Story: “Dividing Up Souls” 

Questions: 
1. Formal education was not available to many members of eighteenth-century society, 

especially enslaved Africans. Enslaved persons did, however, use alternative 
methods, such as storytelling, to teach their children “survival skills.” How does the 
story “Dividing Up Souls” demonstrate this?  

2. What are the values being taught in the story? 
 

Possible Answers: 
The enslaved community, though mixing closely with the members of the master’s 

family, had a unique system of networking by which information could be exchanged. 
For this system to work as a successful survival skill, the enslaved community had to 
keep what they heard within the slave community. One moral to the story is: “Don’t tell 
all you know.” 

In more general terms, the story “Dividing up Souls,” teaches a bit of common sense 
that is useful whether or not one is enslaved: “Don’t believe everything you hear.” 
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Excerpt from The Journal of Nicholas Cresswell, 1774–1777 
Questions: 

1. What aspects of Negro music are identified in the account? 
2. How would you characterize Cresswell’s opinion of Negro music? 

 
Possible Answers: 

Cresswell identifies the instrument being played at the Negro ball as the banjar, or 
banjo. He notes that the slaves sing about the treatment they receive at the hands of their 
masters. He also comments on the energy displayed in the slaves’ style of dance and 
notes that the enslaved community seems to use these gatherings as a way of escaping the 
drudgery of everyday life. 

Cresswell does not seem to appreciate the instruments, musical lyrics, or dance style 
demonstrated by the slaves. He finds it “rude and uncultivated.” However, his opinion is 
undoubtedly influenced by the fact that he is more familiar with European style music in 
which melody is the focal point. In African music, rhythm is the most important 
component. It is also notable, that whites attending balls in the eighteenth century often 
describe ending the ball with a “Negro jig.” This indicates that some whites, being more 
accustomed to the music and dance of the enslaved community, found it worthy of 
imitation. 

 
 
Excerpt from Autobiography of Dick, a Slave 

Questions: 
1. What tasks did Dick undertake during his life as a plantation slave? What were some 

of the skills that he was able to acquire over the years? 
2. What kind of a person was Dick? 

 
Possible Answers: 

Dick was trained to care for horses, hunt, play a musical instrument, and toil in the 
fields. He was a hard worker; fast learner as well as loyal and talented. 

 
 
Spiritual: “Gonna Shout All Over God’s Heaven” 

Questions: 
1. What is the message that is being conveyed in this spiritual? 
2. What inferences can be made regarding life as a slave from this song? 

 
Possible Answers: 

 Slave owners and white ministers in the eighteenth and nineteenth centuries 
frequently used religion as a means of control. Enslaved Africans were taught that if they 
were good slaves on earth, they would receive their “reward” in heaven. However, 
African-Americans found hope and inspiration for the present day in religion. The song 
“Gonna Shout All Over God’s Heaven” celebrates the equality of all people, in defiance 
of slavery. This song is a “shout,” sometimes referred to as a “ring shout” in African 
religious custom retained in North America. The ideology of receiving one’s reward in 
heaven is a basic belief of many Judeo-Christian religions. [NOTE: *For further 
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information on the African “shout”: The Slave Community: Plantation Life in the 
Antebellum South by John W. Blassingame, copyright 1979, Oxford University Press.] 
 As a historian, you might see this spiritual as a song of equality. It reminds us 
that, “I got a robe (crown, shoes…) and you got a robe (crown, shoes…)” Clearly, these 
lyrics demonstrate that enslaved men and women were well aware of the discrepancies 
between their standard of living and that of their masters. Perhaps the line, “everybody 
talkin’ ‘bout heaven ain’t goin’ there,” was directed at those teaching Christianity to 
slaves, but who, in many cases, did not act in accordance with what they taught. [NOTE: 
*For more information on veiled criticisms directed at slave owners in the music and 
stories of enslaved African-Americans: When Birds Could Talk and Bats Could Sing: 
Bruh Sparrow, Sis Wren, and Their Friends by Virginia Hamilton, copyright 1996, 
School and Library Binding and African-American Folktales: Stories from the Black 
Traditions in the New World, compiled and edited by Roger D. Abrams, copyright 1999, 
Pantheon Fairytale and Folklore Library.] 

 
 
Cowrie Shells 

Question: 
1. In African communities, cowrie shells were used as a form of currency. In the 

American colonies, however, enslaved Africans valued the shells for other reasons. 
Based on what you see in this photograph of cowrie shells excavated from an 
archaeological site, how do you think the shells may have been used? 

 
Possible Answer: 

 Since the shells have man-made holes in them, we might assume they were used 
as adornment (i.e. jewelry, adornment for the hair or clothing).
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Using the TI-Navigator™ System 
with this Lesson 

 
 
Introduction 
 
This document provides ideas about how the lesson you have chosen can be enhanced by using the 
TI-Navigator™ Classroom Learning System. Read further to learn about: 

♦ Enhancing Your Lessons with the TI-Navigator™ System 

♦ Sending Files to Your Class 

♦ Receiving and Viewing LearningCheck™ Results From Your Students 

♦ Using LearningCheck™ Results 

 
Notes:  
 
Detailed instructions for specific TI-Navigator™ tasks are available in the Getting Started Guide 
that accompanies the System. 
 
The examples provided in this document will not necessarily match the text you see on your 
computer or device. They are provided as a guideline for using the hardware and software. 
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Enhancing Your Lessons with the TI-Navigator™ System 
♦ Use the TI-Navigator System to efficiently send Notefolio™, LearningCheck™, 

StudyCards™, CellSheet™, and TImeSpan™ files to students, to save time and paper. 

♦ Use the Notefolio™, LearningCheck™, TImeSpan™, or StudyCard™ Creator or the 
CellSheet™ Converter software to modify any of the ready-made lesson files to better fit the 
needs of your students. 

♦ Use the TI-Navigator™ System and LearningCheck™ Application to measure student 
understanding at any point during a lesson. To do this, use the LearningCheck™ Creator 
software to make an assignment using a variety of questioning types such as Likert Scale 
(shown below), Yes/No, Agree/Disagree, and so forth. This technique is an excellent way to 
spark lively class discussions. 

 

 

♦ Use either the Notefolio™ or LearningCheck™ Application to efficiently send student 
instructions, saving time and paper. 

♦ Use the NoteFolio™ or LearningCheck™ Creator software to modify any of the ready-made lesson 
resource files to better fit the needs of your students. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Likert Scale Question 
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Sending Files to Your Class 
 
Most lessons begin with a ready-made file (called an Application Variable or AppVar for short), 
such as a LearningCheck™ file, that you distribute to the class. Using the TI-Navigator™ System, 
you can quickly send these files to the whole class at one time. This eliminates the need for students 
to use the unit-to-unit cables to distribute the files, thus saving valuable class time. With the TI-
Navigator™ System, any student who arrives late to class can obtain their file with minimum 
disruption to the class. 
 
Creating and Sending LearningCheck™ Files 
 
Since the LearningCheck™ Creator software is a part of the TI-Navigator™ System, you can 
quickly check student comprehension during a lesson by creating a file with one or two questions, 
and then sending it to the class. Use the following procedure to send a newly created file using the 
TI-Navigator™ System.  

1. On the computer, click Start > Programs > TI-Navigator > TI-Navigator. The 
TI-Navigator™ System Home screen opens. 

2. Click the LearningCheck™ button on the left to launch the LearningCheck™ Creator program. 
Create the new assessment or assignment. 

Note: Instructions for using the LearningCheck™ Creator are available with the creator 
software. 

3. When the file is completed, click File > Send to > Class. An alternate method of sending files is 
to click on the Send to Class icon.  
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The Transfer window opens, letting you see the progress of the files as they are sent to your class. 

 
Window with Transfer In Progress 

 

4. When the Status column shows Done for all the devices in your classroom, click Done. 

5. Click File > Close to close the LearningCheck™ Creator. Click No when asked whether to save 
your document. Each student has the new file. 
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Sending Existing Files 
 
If you have AppVars (LearningCheck™, CellSheet™, or NoteFolio™ files) already created and 
saved, you can send these to a class without opening the creator software.  

1. Start the TI-Navigator™ System. Select the Edit menu. 

2. Select Add To Transfer List from the Edit menu options. 

 
A box opens that enables you to type the name of the file you want added to the transfer list. If 
you do not know the path and name of the file, click the browse icon to the right of the file name 
box. 
 

 
 
   Add to Transfer List Box with Browse Button Indicated 

  

© 2003 Texas Instruments Incorporated 
 

16 



   

3. If you choose to search for your files, a window opens that enables you to search for the 
AppVars (files) you want to send to the class. Note that these must be device-specific AppVars 
(such as .8xv files), not creator files such as the .edc files from LearningCheck™ Creator.  

 
Browse for Files Box 

 
4.  Double-click the mouse button to enter the name of the file in the File Name field.  

 
Selected File entered 
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5. Click Continue. A Properties window opens before each file is added. This box informs you of 
the target destination and estimated size of the file on the device.  

 
   Send to Class Properties Box 

 

6. Click OK to add a file to the list. Repeat these steps to add all AppVars files you want to 
transmit to the class.  

 
 During class, you can send specific files to the class by clicking the checkbox at the far left of 

the file name in the Class Connect section of the TI-Navigator™ screen. (This is a toggle—turn 
the check mark on/off by clicking on the box. See the example below.)  

 
Send to Class file list (note green Start Transfer button) 

 

 To send the selected file(s), click the Start Transfer button that appears just above the 
Properties column heading. The Transferring window opens and shows the progress of the file 
transfers. When the Status column shows Done for all the devices in your classroom, click 
Done. 
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Receiving and Viewing LearningCheck™ Results from Your Students 
 
Whenever a lesson requires students to send you their completed LearningCheck™ files, you can 
retrieve the file from the entire class almost instantaneously with the TI-Navigator™ System. (Refer 
to the TI-Navigator™ System Getting Started Guide for information on retrieving and viewing 
other file types.) 
 
Use the Class Analysis tool to receive and view results from completed student LearningCheck™ 
files. Access it by clicking the icon in the left bar of the TI-Navigator™ Home screen.  
 
With the Class Analysis tool opened, if you select Collect From Class, the system is automatically 
ready to retrieve the last LearningCheck™ file sent to the students. When file collection is 
completed, the system populates the Class Analysis File with the students’ data.  

 
 

 

      Class Analysis Icon TI-Navigator™ Window Showing File to be Collected 
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Using LearningCheck™ Results 
 
The Class Analysis tool does more than just allow you to quickly retrieve student files. Once you 
have retrieved a set of LearningCheck™ assignments, the software enables you to analyze the 
results of the assignment. With the Class Analysis tool, you have the ability to view and print 

♦ A summary for all students and all questions (responses per question),  

♦ A single student’s results,   

♦ A single item’s responses (item analysis). 

Class Analysis also allows you to display student responses anonymously, allowing you to conduct 
stimulating class discussions based on what was answered instead of who answered what. 

 

Class Analysis Slide Show of Results 
 

 Question To Which Students Responded The Responses for Each Response Option 

 
 
For More Information 
 
For more information about the TI-Navigator™ System, go to education.ti.com and click on the 
link for the TI-Navigator™ System.  
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*     *     *     *     *     *     * 
 
This TI-83 Plus lesson was adapted from Slavery: A Colonial Odyssey, a lesson unit available from 
the Colonial Williamsburg Foundation. For more information on this lesson unit and other Colonial 
Williamsburg instructional materials and classroom resources, visit http://www.history.org/teach, or 
call 1-800-688-6473. 
 
Special thanks for developing this lesson go to: 
Janet P. Brooks, AP U.S. History teacher, Liverpool High School, Liverpool, NY 
Charles R. Coon, Adjunct Professor of Education, State University of New York at Oswego, 
 Oswego, NY 
Bob Van Amburgh, Instructional Supervisor for Social Studies, City School District of Albany, NY 
Kathryn Robinson, teacher and Texas Instruments T3 Instructor, Parkville High School, 
 Baltimore, MD 
Colonial Williamsburg Foundation Department of Education Outreach staff  
Texas Instruments staff 
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